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1 Release announcement

1.1 The GIMP hits 2.0!

The GIMP developers are proud to release version 2.0 of
The GIMP, the leading free software tool for image ma-
nipulation.

This release is a major event, marking the end of a three
year development cycle by a group of volunteers and en-
thusiasts who have made this the most professional re-
lease of the GIMP ever. It is the first stable release that
is officially supported not only on Unix-based operating
systems, but also on Microsoft Windows and Macintosh
OS X.

Figure 1: The all-new GIMP 2.0

The GNU Image Manipulation Program (GIMP) is
ideal for amateur photographers, web designers, and
many other people who want to create and edit digital
images. It is a very powerful application, with features
including: channels and layers; colour operations such as
levels, curves and threshhold; advanced selection opera-
tions using intelligent scissors and selection channels; and
much more.

GIMP is free software, which means it can be freely
distributed and modified. This makes it well suited to be
included on coverdisks of magazines dedicated to digital
photography or image editing, or to be included with dig-
ital cameras, scanners, printers etc. As free software, its
capabilities are ultimately limited only by the collective

imagination of the community of free software contribu-
tors.

Figure 2: Brush outlines

Started in 1995 by Spencer Kimball and Peter Mattis,
the GIMP has evolved into a mature and powerful appli-
cation. The latest release has major improvements in the
user interface, making the GIMP more accessible for ca-
sual users as well as graphics professionals. The quality of
the code base has also been substantially improved, mak-
ing it easier for the open source community to contribute
useful and high-quality add-ons to the GIMP.

The GIMP continues its tradition as a testbed for tech-
nologies that have proven to be useful for other applica-
tions as well. The popular library GTK+ (Gimp Toolkit,
http://www.gtk.org/) started as a part of the GIMP and
now is in wide use on Linux as well as Win32 plat-
forms. Gimp-Print (http://gimp-print.sourceforge.net/)
has evolved into a set of high-quality printer drivers.

1.2 Quotes

Linux Magazine France, March 2004: ”This
new version... fulfils its promise.” ”In general,
the user interface is easier to use [and] more co-
herent... To save screen real estate, all dialog
boxes ... can now be grouped together in one
window using a tabbed interface... Soon you
will have no more excuses for using Photoshop”

Newsforge, Bruce Burgess, Feb 25, 2004:
”When you launch version 2.0 you’ll see a new
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look that’s a huge improvement over the pre-
vious version’s mundane and purely functional
interface. The new design not only provides a
polished and comfortable feel, it is also far more
intuitive and friendly than its predecessor.”

Figure 3: The text tool

1.3 Availability

• The GIMP is available as a free source code
download at ftp://ftp.gimp.org/pub/gimp/v2.0/gimp-
2.0.tar.gz

• GIMP GAP is available for down-
load at ftp://ftp.gimp.org/pub/gimp/plug-
ins/v2.0/gap/gimp-gap-2.0.tar.gz

• GIMP Freetype is available at...

• GIMP-perl is available at...

• GIMP help files are available at...

• The GIMP plug-in template is available at...

Figure 4: The GIMP on OS X
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2 What’s new in GIMP 2.0

2.1 Introduction

GIMP 1.0 evolved gradually into the very stable and
widely used 1.2 release. Three years later, as GIMP de-
velopment came closer to the next stable release, the de-
velopment team decided to call the new version 2.0. Here
are a few of the changes brought by the new Gimp release.

From the user’s point of view, Gimp 2 is fundamen-
tally similar to Gimp 1; features available in the older ver-
sion are still available in the GIMP 2.0. However, a huge
amount of work has led to a complete restructuring of the
GIMP internals. The Gimp 2 code base is significantly
better organized, more maintainable and more easily ex-
tended than was the case for Gimp 1.2.

2.2 Basic tools

The basic tools in GIMP 2 are not very different from
their predecessors in Gimp 1. The select regions by color
tool is now shown in the GIMP toolbox, but was already
included in Gimp 1 as a menu option in the Select menu.

Figure 5: The GIMP toolbox

The Transform tool has been divided into several spe-
cialized tools: Rotation, Scale, Shearing and Perspective.
Color operations are now associated with layers in the
menu ”Layer-¿Colors”, which is their logical place: in

previous versions they were in the Image menu, despite
the facts that they are layer operations.

Thus no completely new tools appear in this release,
but two of the tools have been totally rewritten: the Text
tool and the Path tool.

2.3 The Text Tool

The big problem with the standard text tool in Gimp 1
was that text could not be modified after it was rendered.
There was a ”dynamic text” plugin that allowed you to
create special text layers and keep them around indefi-
nitely, in a modifiable form, but it was buggy and awk-
ward to use.

The second generation Text tool is an enhanced combi-
nation of the old Text tool and the Dynamic Text plugin.
Now all options are available in the ”Tool Options”: font,
font size, text color, justify, antialiasing, indent, spacing.

Figure 6: The Text tool in action

To create a new text item, click in the image and a lit-
tle editor pops up. Text appears on the image while you
are editing (and carriage returns are handled properly!). A
new dedicated layer is created; this layer resizes dynami-
cally to match the text you key in. You can import plain
text from a file, and you can even do things like writing
from right to left in Arabic or Hebrew. If you select a text
layer, clicking on it opens the editor, and you can then
modify your text.

2.4 The Path Tool

The next generation Path tool has a completely new inter-
face. The first major difference you notice is that paths
are no longer required to be closed. A path can be made
up of a number of disjoint curve segments. The next ma-
jor difference is that now the path tool has three different
modes, Design, Edit and Move.
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In Design mode, you can create a path, add nodes to an
existing path and modify the shape of a curve either by
dragging edges of the curve or dragging the “handles” of
a node.

In Edit mode, we can add nodes in the middle of curve
edges, and remove nodes or edges, as well as change the
shape of the curve. You can also connect two path com-
ponents.

The third mode, Move, is, as you might expect, used to
move path components. If your path has several compo-
nents, you can move each path component separately. To
move all components at once, use the Shift key.

All of the Path tool functions are available via the key-
board, using some combination of Alt, Shift and Ctrl.
Keep an eye out on the information bar at the bottom of
the information window for helpful hints on how to access
the various modes using these buttons.

Figure 7: The Path tool, working on an imported SVG
image

Two other path-related features are new in the GIMP
2.0. The GIMP can not only import an SVG image as a
raster image, but can also keep SVG paths intact as GIMP
paths. This means that the GIMP is now more able than
ever to complement your favourite vector drawing tool.

The other feature which has made the path tool much
better is the introduction of vector-based stroking. In pre-
vious versions, stroking paths and selections was a matter
of drawing a brush-stroke along the path. This mode is
still available, but it is now possible to stroke a curve ac-
curately, using the vector library libart.

2.5 User Interface

The most visible changes in Gimp 2 concern the user
interface. Gimp now uses the GTK2+ graphical toolkit
in place of GTK+. One of the nice features brought by
the new libraries is dockable dialogs, and tab navigation

Figure 8: Stroking paths is now much more flexible

between dialogs docked in the same window – this fea-
ture gives you maximum flexibility in organizing your
workspace.

The Image window has some interesting new features.
These are not necessarily activated by default, but they
can be checked as options in the ”Preferences-¿Interface-
¿Image Windows” menu. ”Show Brush Outline”, for ex-
ample, allows you to see the outline of the brush when
using drawing tools.

A welcome new addition for many users is a menu on
the top of each image window. For people who prefer
screen real estate, this (and all the other window decora-
tions) are optional, and can be turned off per-image or by
default.

Also making an appearance for the first time is a full-
screen editing mode. This mode can be toggled using F11,
or via the View menu. This mode has its own set of pref-
erences for things like selection outlines and the menubar
- so that you can turn off all distractions and concentrate
on what’s important, the image.

To ease access to your most commonly used menu
items, the GIMP has provided dynamic shortcuts for
many years. When a menu is open, you can hover over
the desired menu item and hold down your shortcut com-
bination. This feature is still present, but is disactivated by
default in the GIMP 2.0, to avoid accidental re-assigning
of existing shortcuts.

The GIMP also ships with a number of sets of key-
bindings for its menus. If you would like to replace the
default GIMP keybindings by Photoshop bindings, for
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Figure 9: Full screen mode with the grid enabled

example, you can move the file ”menurc” in your user
data directory to ”oldmenurc”, and rename ”ps-menurc”
to ”menurc”.

2.6 Handling Tabs and Docks

The GIMP 2.0 introduces a system of tabbed dialogs to
allow you to make your workspace look the way you want
it to be. Almost all dialogs can be dragged to another
dialog window and dropped to make a tabbed dialog set.

Furthermore, at the bottom of each dialog, there is a
dockable area: drag and drop tabs here to attach dialogs
beneath the bottom tab group.

2.7 Scripting

”Python-fu” is now the standard external scripting inter-
face for Gimp 2. This means that you can now use Gimp
functions in Python scripts, or conversely use Python to
write Gimp plug-ins. Python is relatively easy to under-
stand even for a beginner, especially in comparison to the
Lisp-like Scheme language used for Script-fu in Gimp 1.
The Python bindings are augmented by a set of classes
for common operations, so you are not forced to search
through the complete Gimp Procedural Database in order
to carry out basic operations. Moreover, Python has inte-
grated development environments and a gigantic library,
and runs not only on Linux but also on Microsoft Win-
dows and Macintosh OS X. The biggest drawback, for
Gimp 2.0, is that the standard user interface offered in
Python-fu does not use the complete power of the Python
language. The interface is currently designed to support
simple scripts, but a more sophisticated version is a goal
of future development.

Gimp-Perl is no longer distributed with the standard
Gimp 2 distribution, but is available as a separate pack-
age. Currently, Gimp-Perl is supported only on Unix-like

Figure 10: Dockable dialogs

operating systems. It includes both a simple scripting lan-
guage, and the ability to code more polished interfaces
using the Gtk2 perl module. Direct pixel manipulation is
available through the use of PDL.

Script-fu, based on Scheme, has the same drawbacks as
before: not intuitive, hard to use and lacking a real devel-
opment environment. It does, however, have one major
advantage compared to Python-fu: Script-fu scripts are
directly interpreted by Gimp and do not require any ad-
ditional software installation. Python-fu requires that you
install a package for the Python language.

2.8 Other improvements

Some other improvements in brief:

• Menus that don’t fit on the screen can scroll.

• Higher-quality antialiasing in some places – most
notibly in the Text tool.

• Icons and menus are skinnable. You can create
your own icon set and apply it to the toolbox using
the ”Preference-¿Interface” menu option. A theme
called ”small” is included with the standard distribu-
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tion, and you can see below the appearance of the
toolbox in it (ideal for low resolutions):

• An image can be saved as a template and used to
create new images.

• There are four new combination modes for layers
that lie one on top of another within an image: Hard
Light, Soft Light, Grain Extract and Grain Merge.

• The Alpha channel, used for the transparency, is now
available in the Channels dialog as for primary colors
red, green and blue.

• The Fill tool behaves a bit differently than before.
Now, by default the selection is not filled completely;
when you use the fill tool with an active selection,
the part of the image filled is the intersection of the
active selection and the region in which you click.
This makes the fill tool behave similarly to other
tools with respect to selections. There are, however,
two ways to fill a full selection - use the menu en-
try ”Edit-¿Fill”, or change the behaviour of the fill
tool to ”Fill Whole Selection”, which has the same
behaviour as in GIMP 1.2.

• If there is an active selection, you can crop the im-
age directly to the selection size using image menu
”Image-¿Crop”.

• As well as being able to create guides, there’s now
a grid functionality in GIMP. It is complimentory to
the guides functionality and makes it easier to posi-
tion objects so that they align perfectly.

• The Layers dialog is more coherent, in that there are
no more hidden functions accessed only with right
click on the miniature image of the layer that appears
there. You can now handle layer operations directly
from the image menu: Layer Mask, Transparency,
Transformation and Layer Color operations are di-
rectly in Layer submenu.

• Color display filters are now available from the im-
age menu ”View-¿Display Filters”. Using them, you
can simulate different gamma values, different con-
trasts, or even color deficient vision, without altering
your original image. This actually has been a feature
of the GIMP developer versions for a long time, but
it has never been stable enough to appear in a stable
version of the GIMP before.

• The color selection dialog has a new CMYK mode,
associated with the printer icon.

• Path rendering has been considerably improved.
New libraries (libart) are used to render paths, and
they are obviously more effective. A new dialog is
available using the image menu ”Edit-¿Stroke path”;

this new dialog allows you to choose any paint tool,
or any of the standard stroke styles. In the latter case,
you can set different dash patterns, as well as the cap
and join style. You can even stroke the edge of an ac-
tive selection using ”Edit-¿Stroke Selection”, which
allows same stroke options as for paths.

• Data stored in EXIF tags by digital cameras are now
handled in read and write mode for JPEG files.

• The Scalable Vector Graphics (SVG) format can be
imported by Gimp 2. The SVG format is a standard
for the web; it is natively handled by Sodipodi, via
filter by Sketch and by numerous other vector ori-
ented graphic tools. It’s now possible to work com-
fortably with vectorized objects and import them into
Gimp to paint them, as can be done with Adobe Il-
lustrator and Photoshop. When opening a SVG files,
GIMP rasterizes the content in a given resolution but
it also allows to import SVG paths. You can then
finalize the shapes in Gimp or trace them using the
”Stroke Path” operation. Gimp paths can also be ex-
ported as SVG files, so you can reuse at least some
of your Gimp work in any vector graphic tools.

• MNG animations are now supported. The MNG file
format can be considered as animated PNG. It has all
the advantages of PNG over GIF, such as more col-
ors, 256 levels of transparency, and perhaps most im-
portantly, lack of patent encumbrance. The format is
a web standard and all recent popular web browsers
support it.

• The Animation package now does onion-skinning, a
bluescreen feature was added as well as audio sup-
port.

• A channel mixer filter, previously available from the
web as an add-on, appears in ”Filters-¿Colors”.
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